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Introduction to TTGraph For Windows

TTGraph For Windows software supplies a primary part of the Toledo Transducers Inc. press
monitoring system.

TTGraph displays press curves and signals that Toledo Transducers Inc. Tonnage Monitors read.

The program provides Graphical as well Tabular Data for analysis of force from metal forming
machines.

In its updated Windows version TTGraph is user-friendly with simple commands and user-ready
software.

This user’s manual will provide you with the necessary tools to use TTGraph for Windows.

System requirements:

Windows 3.1x or higher
386 PC or higher
4 MB RAM
One unused Com Port or network access to PressNet
RS232 or RS485 interface
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Chapter One: Installing TTGraph For Windows

WINDOWS 95
(If you are using Windows 3.1x, please see the next section.)

1. Insert the installation disk into your floppy disk drive. Choose Run in the Start menu. (See Fig. 1)

Figure 1: Run window from the Start menu.

2. Type A:\ setup and hit Return or click on OK. (See Fig.1)
     (If A is not your floppy drive, please substitute the appropriate drive letter.)

3.  Follow the TTGraph for Windows Installation program.

4.  When you have completed the installation, start the program.

5.  Choose Directory in Setup on the menu bar.

6.  Type appropriate directories for TTGraph and PressNet. (See Fig. 2).

Figure 2: Directory window.

Where TTGraph.EXE
could be found.

Where comportx.CFG
could be found.
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7.  Choose Driver in Setup on the menu bar.

8.  Choose Add. (See Fig. 2a).

9.  Choose your monitor. Then choose OK.(See Fig. 2b).

10.  Choose which monitor to use a Default.

11.  Then choose OK.

   
.

Figure 2a: Driver Window                                               Figure 2b: Add Driver

Add

Monitor
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WINDOWS 3.1X

(If you are using Windows 95, please skip this  section.)

1. Insert the installation disk into your floppy disk drive. Choose Run in the File menu. (See Fig. 3).

Figure 3: Run from the File menu.

2. Type A:\ setup and hit Return or click on OK. (See Fig.3)
     (If A is not your floppy drive, please substitute the appropriate drive letter.)

3.  Follow the TTGraph for Windows Installation program.

4.  When you have completed the installation, start the program.

5.  Choose Directory in Setup on the menu bar.

6.  Type appropriate directories for TTGraph and PressNet. (See Fig. 2).

7.  Choose Driver in Setup on the menu bar.

8.  Choose Add. (See Fig. 2a).

9.  Choose your monitor. Then choose OK.(See Fig. 2b).

10.  Choose which monitor to use a Default.

11.  Then choose OK.

Chapter Two: Connection to Tonnage Monitors
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TWO CHOICES: RS485 OR RS232
1. Use RS232 to connect one laptop to a tonnage monitor. (See this section).
2. Use RS485 for plant wide connections. (See following section).

Connect with RS232 connector (See Fig. 4)
(If you are using the RS485 connection, please go to next section.)

Ø The RS232 uses either a 9 pin or 25 pin connector. The 9 pin is most common.
Ø The RS232 is used to attach one monitor to one computer.
Ø The RS232 is commonly used for laptop or portable computers.
Ø The RS232 cable length is limited to 50 ft.

Connect to computer:

1. Locate one serial Com port often in the back of the PC. Be sure it matches your connector.  (I.E. A
9 pin connector should be connected to a 9 pin Com port.)
(Note: Com 1 is the TTGraph for Windows default port, but can easily be changed when
downloading signatures. See page 5.).

Connect to Monitor

Please see your respective installation manuals to attach RS232 to the N260, Quick-Learn, TQM or
PW monitors.

Figure 4: RS232 connection.

Connect with both RS485 and RS232 connection
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Ø It is necessary to use an RS485 connection for networking more than one tonnage monitor to a
computer. This is done by using a Sencon converter between the RS232 and RS485.
Ø The RS485 is used to connect up to 32 monitors.
Ø The RS485 is limited to 4000 feet cable.

Connect to computer from tonnage monitor

1. See Figures 4, 5 and 5a.

Figure 5: RS485 connection with Sencon converter.

From Monitor Suggested wire
color

To SENCON
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R+ Blue / White TX 422 - Out

R - Blue TX 422 + Out

Ground G & G / White Common

T - Orange RX 422 + / 232 In

T + Orange / White RX 422 - In

From SENCON To Computer 9 Pin Connector

RX 232 Blue Pin 2 Receive

TX 422+ / 232 Red Pin 3 Transmit

G (ground) Green Pin 5 Ground

From SENCON To Computer 25 Pin Connector

RX 232 Red Pin 3 Receive

TX 422+ / 232 Blue Pin 2 Transmit

G (ground) Green Pin 7 Ground

On the top of the converter the switch on the monitor side must be set to 422 and the switch on
the computer side must be set to 232.

A 120-ohm resistor must be connected, at the converter, between Common and
RX 422+ / 232 on the monitor side.

If all connections are proper, when the computer is connected to the converter the 3rd LED
from the top on the converter will flash every time the computer asks for information. The top
LED will flash every time the monitor responds.

Figure 5a: RS485 connection with Sencon converter.

Chapter Three: Downloading Signatures
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DOWNLOADING FROM  A COM PORT

(If you are using the PressNet network, you will be unable to download from a
com port. Please see next section.)
 

1.  Choose Signature on the menu bar at the top left of your screen.
2.  Choose Download from COM Port.
3.  The Download window will appear (See Fig. 6).

Figure 6: Download window.
 

4.   Choose the Com: Port connected to your monitor(s). (See Fig. 6).
(Note: Com 1 is set as default. See Fig. 6.)

5.  Choose your monitor in the Driver menu. (See Fig. 7).
(Note: There are three choices for drivers: Quick Learn, PW and N260Load Monitors.)

Figure 7: Driver menu in the Download window.

6.   Choose Address and input the proper monitor address. (See Fig. 7a).
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Figure 7a: Driver menu in the Download window.

7.  Click on Download. Your computer will download signatures.

DOWNLOADING FROM PRESSNET

(If you are using the PressNet network, you will only be able to download from
PressNet.)
 

1.  Choose Signature on the menu bar at the top left of your screen.
2.  Choose Download from PressNet.
3.  Choose a Press address in the Downloading from PressNet window. (See Fig. 8).

Figure 8: Downloading from PressNet window.

4.  Click on Download. Your computer will download signatures.

SAVE A SIGNATURE AS A SIGNATURE FILE (*.SIG)

Press address

Monitor Address
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1.  You may save a signature by choosing File in the menu bar and then choosing Save. You will then
be able to input signature information. (See Fig. 9). The information will be displayed at the top of
your screen.

2.  You may view signature information later by Choosing Signature on the menu bar and then
Choosing Description.

3.  View or change any useful signature information. (See Fig. 9).

Figure 9: Signature Information window.

OPEN A SIGNATURE FILE

1.  You may open a saved signature by choosing File on the menu bar and then choose Open.

SAVE A SIGNATURE AS A REFERENCE FILE (*.SRF)

1.  You may save a signature by choosing File in the menu bar and then choosing Save.   You will then
be able to input signature information. (See Fig. 9). The information will be displayed at the top of
your screen.

2.  You may view signature information later by Choosing Signature on the menu bar and then
Choosing Description.

3.  Only signatures (not press curves) are saved as *.SRF

OPEN A REFERENCE FILE

1.  You may open a saved signature by choosing File on the menu bar and then choosing Open.
2.  You will need to load a signature file before you open a reference file.
3.  Reference signatures are gray.
4.  You may view a reference signature when in outer or inner, but  not both.

EXIT AND SAVE VIEW

1.  You may exit and save your setup view (In the View menu on the menu bar) by choosing File on the
menu bar and then choose Exit and Save view.



TTGRAPH FOR WINDOWS    8/97                          12

PRINTING SIGNATURES

1.  You may print signatures by choosing File on the menu bar and then choosing Print.
2.  You may choose to print the Corners, Total or Data Table and may print corner on the same or

different pages. (See Fig. 10).

Figure 10: Print Window

Chapter Four: Viewing Signature Windows

VIEWING EACH CORNER AND TOTAL SEPARATELY



TTGRAPH FOR WINDOWS    8/97                          13

1.  To view the press Corners and Total separately, choose Window from the menu bar.
2.  In Window choose Right Rear, Left Rear, Right Front, Left Front or Total.
3.  If you are already viewing all five Signature windows, simply minimize each window you choose not

to view.

TILE VIEW

1.  Choose Window on the menu bar and then choose Tile to see all four corner signatures
simultaneously. (See Fig 11).

(Note: Tile View is the default display.)

Figure 11: Signatures in Tile view.

CASCADE VIEW

1.  Choose Window on the menu bar and then choose Cascade  to see all four corner signatures (and
the Total) Cascaded. (See Fig 12).
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Figure 12: Signatures in Cascade view.

VIEW THE OUTER

1.  Choose View on the menu bar and then choose Outer at the top left of your screen. This allows you
to view only the outer ram signature(s). (See Fig. 13).

Figure 13: Signature in Outer view.
VIEW THE INNER

1.  Choose View on the menu bar then choose Inner to view only the Inner ram signature(s). (See Fig.
14).
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Figure 14: Signature in Inner view.

VIEW THE OUTER AND INNER

1.  Choose View on the menu bar and then choose Outer and Inner to view both the Outer and Inner
ram signature(s). (See Fig. 15).

(Note: Only for use with double action presses.)

Figure 15: Signature in Outer and Inner view.

VIEW DEGREES AND INCHES (WITH RESOLVER)
(Note: You will view milliseconds when using PW and Quick Learn monitors.)

1.  To use Degrees as measurement of your signature, choose View on the menu bar and then choose
Deg (Degrees).
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2.  To use inches as measurement of your signature, choose View on the menu bar and then choose In
(Inches).

THREE WAYS TO SCALE YOUR SIGNATURES

Choose View on the menu bar to see the scaling choices.

Scale To Fit

1.  Choose View on the menu bar and then choose Scale to Fit
2.  This scaling will allow you to see the signatures and press curves in maximum scale. (See Fig. 16).
(Note: When viewing both outer and inner the percentage of the capacity is shown. The
outer and inner use different scales).

Figure 16: Scale To Fit.

Scale Uniformly by Capacity

1.  Choose View on the menu bar and then choose Scale Uniformly by Capacity.
2.  This scaling will allow you to see the signatures and press curves in maximum scale.
(See Fig. 17).
(Note: The outer and inner use the same scales.)
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Figure 17: Scale Uniformly by Capacity.

Scale Uniformly by Highest Peak

1.  Choose View on the menu bar and then choose Scale Uniformly by Highest Peak.
2.  This scaling will allow you to see the signatures in maximum scale by viewing the  highest peak of all
corners. (See Fig. 18).

Figure 18: Scale Uniformly by Highest Peak.

Chapter Five: Using Signature Windows

HOW TO READ SIGNATURE WINDOWS
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Figure 19: Signature Window.

HOW TO READ TABULAR DATA

Tabular Data
1. For complete signature data choose Tabular Data in Signature on the menu bar.

Figure 20: Tabular Data screen.
Use Tabular Data and Signatures Together

Outer ram
Capacity and
Press Curve

Shows in tons or
the percentage
capacity.

Shows degrees
or inches.

Inner ram
Capacity  and
Press Curve

Actual Inner
ram hit.

Actual Outer
ram hit.

Degrees

Inches

Inner and Outer
Degrees and inches

Press Inner and
Outer

Actual HitsTotal Capacity

Corner
Capacity
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1.  You have the option to use the Tabular Data feature and signatures together. This allows you to left
mouse click on the signature and move a positioning line to any desired point on the signature to receive
data. (See Fig. 21)
2.  To remove the data from the screen right click on the signature or press ESC.

Figure 21: Signature and Tabular Data.

Data Sheet Position line


